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User Guide 

This document is generated automatically from our ReqTeam help center located 
at https://documentation.reqteam.com. The following content represents a comprehensive 
usage guide for ReqEdit application and features. 

Our goal is to keep the presented information accurate. If there are any mismatches to your 
version of ReqEdit, please notify us. Thank you for your understanding. 
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Create document in REQEDIT 

ReqEdit creates different types of requirement documents. 

¶ New specification (.reqif) 

You can create a new specification document withouth attachements. 

¶ New specification with attachements (.reqifz) 

You can create a new specification document with attachments, images, file attachments 
based on ReqIF format from default or template. This option is recommended to use, vs the 
simple reqif documents. 

More about ReqIF formats read here. 

ReqIF (.reqif) ReqIF Archive (.reqifz) 

No attachments Can have attachments 

CTRL+N CTRL+SHIFT+N 

Create a new specification document 

 
Dashboard 

 

 

https://documentation.reqteam.com/reqif-requirements-format/
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Create a new specification document: 

¶ Click on the wanted option on the Dashboard or 
¶ Open File menu/New... and choose the option you want to use 

 
File menu 

 

 

New Archive 

ReqIF Archive supports attaching external images or files to any requirement. Creating a 
new archive will show a window asking for a filename. 

Choose default template from the Template selector pop-up window. 

A new file template appears. 

 
New Template 

 

 

An overview of the user interface description, read here. 

Adding new items 

https://documentation.reqteam.com/user-interface/
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Now you can add rows, add columns (attributes) to your document. 

To add rows click File/Edit/Insert new row ... or Insert new child row 

To delete rows click File/Edit/Delete row 

To add Column go to Settings/Document or use shortcut key F8 

In the Document settings table use Attributes tab to add new or edit or delete columns. 

 
Document settings 

https://documentation.reqteam.com/document-settings/
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Attribute editor 

 

 

Note: You cannot edit a created attribute type after saving it. 

More about attributes and attribute types read here. 

Attachments 

ReqIF Archive .reqifz files support having file attachments for objects.  

Only XHTML attributes can have attachments inside .reqifz files 

Image attachments: png, bmp, jpg, gif, ico, wmf, 

File attachments: any file type is supported: pdf, doc, docx, xls, xlsx é 

Inserting file attachments 

https://documentation.reqteam.com/document-settings/#Attributes
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To add an attachment simply right click the XHTML inline editor area and select Insert 
image or Insert file 

 
ReqEdit displaying context menu, highlighted is the insert image and file menu item 

 

 
ReqEdit displaying attachment previews of an object, contains file icons and preview images 

 

 

About editing an opened specification file read here. 

Opening existing files, read here. 

Quick start guide 

1. Download ReqEdit 

Read how to download ReqEdit trial and how to install and start it. 

https://documentation.reqteam.com/edit-reqif-requirement-files/
https://documentation.reqteam.com/open-reqif-requirement-files/
https://documentation.reqteam.com/reqedit-demo/
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For the purchased product you get downloading and installing details by email from the 
sales department. 

2. Install ReqEdit 

First check the system requirements for the ReqEdit application.  

Run the Portable-Installer from the directory, you downloaded it. The Portable-Installer 
guides you through the installing process. 

For trial the activation happens automatically. 

Read more on Install ReqEdit. 

3. Activate ReqEdit for purchased version 

The License activator window appears. In the text box enter the Product key and press the 
Activate button.  

Note: You need to have non-restricted Internet acces, or need to configure the proxy 
settings for it. 

For overall view for activating methods, read here. 

4. Run ReqEdit 

For run use the desktop icon or start "reqedit.exe" directly from the installation directory. 

5. Use cases 

¶ Create document 
¶ Open document 
¶ Import IBM Rational DOORS© RIF Files 
¶ Import MS Word to ReqIF 
¶ Import MS Excel to ReqIF 
¶ Print opened document 

ReqIF requirements format 

RIF/ReqIF (Requirements Interchange Format) is an XML file format suitable for lossless 
exchange of requirements in any industry. The old way of transmitting requirements were 
lossy like Office Documents, PDF or Spreadsheets, ReqIF offers solutions to keep the data 
integrity through the supply-chain. 

It is used to exchange requirements, along with its associated metadata, between software 
tools from different vendors. ReqIF keeps the data integrity of requirements, attributes, 

https://documentation.reqteam.com/starting-reqedit/#System-Requirements
https://documentation.reqteam.com/starting-reqedit/#Installation
https://documentation.reqteam.com/licensing-models/
https://documentation.reqteam.com/?p=2163
https://documentation.reqteam.com/open-reqif-requirement-files/
https://documentation.reqteam.com/importing/
https://documentation.reqteam.com/importing/#MS-Office-Word-Import
https://documentation.reqteam.com/excel-importer-add-on/
https://documentation.reqteam.com/printing/
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additional files (e.g. images) through the supply-chain. ReqIF format also defines a workflow 
for transmitting the status of requirements between partners. Each object is uniquely 
identified by GUID (globally unique identifier inside a RIF / ReqIF file), ensures unique 
content across the data exchange processes. 

The interchange standard 

Main players of the automotive industry in Germany agreed to conform to the RIF/ReqIF 
joint standard, initially developed by HIS Group, ProSTEP iViP, now maintained by OMG. 
(Object Management Group) 

History 

In 2004, HIS (Herstellerinitiative Software) a consortium of German automotive 
manufacturers, defined a generic requirements interchange format called RIF. 

The format was handed over in 2008 to ProSTEP iViP e.V. for further maintenance. A 
project group responsible for international standardization further developed the format and 
handed over a revised version to  Object Management Group (OMG) as "Request for 
Comment" in 2010. 

As the acronym RIF had an ambiguous meaning within the OMG, the new name ReqIF was 
introduced to separate it from the W3C's Rule Interchange Format. 

In April 2011, the version 1.0.1 of ReqIF was adopted by OMG as a formal specification 
(OMG Document Number: formal/2011-04-02). 

In October 2013, version 1.1 was published (OMG Document Number: formal/2013-10-01). 
Changes are restricted to the text of the standard, the XML schema and underlying model 
have not changed. Therefore, 1.1 and 1.0.1 .reqif files are equivalent. 

In July 2016, version 1.2 was published (OMG Document Number: formal/2016-07-01). Like 
with the previous versions, changes are restricted to the text of the standard, the XML 
schema and underlying model have not changed. Therefore, 1.2, 1.1 and 1.0.1 .reqif files 
are equivalent. 

Source: wikipedia.org 

Naming conventions and structure of ReqIF files 

The Prostep iViP published a guide how to exchange with ReqIF and an implementation 
guide for ReqIF, where you can find detailed information how to use this file format and also 
about the file structure, naming convention and interchange. To read about it, click on the 
link: 

Prostep iViP - ReqIF Recommendation 

https://en.wikipedia.org/wiki/ProSTEP_iViP
https://en.wikipedia.org/wiki/Object_Management_Group
https://en.wikipedia.org/wiki/Rule_Interchange_Format
https://en.wikipedia.org/wiki/Requirements_Interchange_Format
https://www.ps-ent-2023.de/fileadmin/prod-download/Recommendation_ReqIF_V2.1_final.pdf
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We recommend to read the chapter 2, to get an overview about the common use cases of 
ReqIF file exchange. Chapter 3 describes the custom attributes used in ReqIF, and chapter 
4 specifies the workflow of the SRC process. 

Prostep iViP - ReqIF Implementation Guide 

For more technical details please look at the Prostep Implementation Guide. We 
recommend to study the chapter 2.1-2.3 for an overview. 

Install ReqEdit 

System Requirements 

Microsoft Windows x64 
.Net 4.7.2 runtime package 
MS EDGE browser or Chrome (for Compare Add-on HTML report) 

Operating systems 

OS Version 
Tested 

configuration 
Limitations 

Windows 11 Pro x64 
.Net 4.8 / 23H2 
EDGE included 

 

Windows 10 Pro x64 
.Net 4.8 / 22H2 
EDGE included 

 

Windows 8.1 x64 
EOL 2023-01-10 

.Net 4.8 
EDGE manually 
installed 

 

Windows 7 Enterprise x64 
EOL 2020-01-14 

.Net 4.8 
EDGE installed 
manually 

 

Windows Server 2022 
Data Center x64 

.Net 4.8 
EDGE included 

 

Windows Server 2019 
Data Center x64 

.Net 4.8 
IE11 included 

on IE11 - HTML compare report, some 
features are missing 

Windows Server 2016 
Data Center x64 

.Net 4.8 
IE11 included 

on IE11 - HTML compare report, some 
features are missing 

Windows Server 2012 R2 
x64 
EOL 2023-10-10 

.Net 4.8 
IE10 included 
IE11 installed by 
update 

on IE11 - HTML compare report, some 
features are missing 

https://www.ps-ent-2023.de/fileadmin/prod-download/Recommendation_ReqIF_V2.1_final.pdf#page=3
https://www.ps-ent-2023.de/fileadmin/prod-download/Recommendation_ReqIF_V2.1_final.pdf#page=19
https://www.ps-ent-2023.de/fileadmin/prod-download/Recommendation_ReqIF_V2.1_final.pdf#page=24
https://www.ps-ent-2023.de/fileadmin/prod-download/Recommendation_ReqIF_V2.1_final.pdf#page=24
https://www.ps-ent-2023.de/fileadmin/prod-download/prostep-ivip_ImplementationGuide_ReqIF_V1-8.pdf
https://www.ps-ent-2023.de/fileadmin/prod-download/prostep-ivip_ImplementationGuide_ReqIF_V1-8.pdf
https://www.ps-ent-2023.de/fileadmin/prod-download/prostep-ivip_ImplementationGuide_ReqIF_V1-8.pdf#page=8
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Windows compatibility of ReqEdit 2.22 (2024 Feb) 

 

 

Installation 

ReqEdit comes packaged into an installer that guides users through the install procedure. It 
will unpack the files into a custom user directory. 

Run the Installer 

 
Window Install ReqEdit 

 

 

Run the provided installer executable and go through the steps, default install path is the 
user profile folder in windows. 



19 / 240 

On the last step of the installer you can choose to activate the license. For that check the 
checkbox. 

 
Window Start Activation Setup 

 

 

Licensing Models 

After installation follow your model of licensing. More about licensing read here. 

Downgrade functionality for ReqEdit Premium 

More information about downgrading functionality read here. 

User Interface 

Overview 

https://documentation.reqteam.com/licensing-models/
https://documentation.reqteam.com/reqedit-downgrading-functionality/
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The look and feel of the application is similar to any classic Windows application. It has a 
main menu at the top, function icon groups that can be rearranged, main content area and a 
status bar at the bottom. 

At first run a quick action dashboard is shown. 

 
ReqEdit start screen showing the dashboard 

 

 

After opening a ReqIF file, the contents will be shown in the main user interface. If the 
ReqIF contains multiple specifications it will be displayed as color coded tabs. 
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ReqEdit showing a ReqIF file, from left to right: navigator panel, requirements and auto-backup panel 

 

 

Specification tabs 

Opening a ReqIF file will display all the specifications as tabs. Same color tabs are from a 
single ReqIF or ReqIF Archive file. The specification title is displayed as the tab title. 

 
ReqEdit displaying specifications inside a ReqIF file in color coded tabs 

 

 

Keeping the mouse over a tab will display more info of the specification like: file location, 
document id, and so on. 

Rename/delete specifications 

Right -click on the specification tab to rename or delete it. 
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Closing opened files 

Close any tab by pressing the X of the tab or by pressing CTRL+W , if there are any 
unsaved changes a popup will ask to save the specification. 

Closing all opened specifications of a ReqIF file by accessing File > Close All or by 
pressing CTRL+SHIFT+W, if there are any unsaved changes a popup will ask for 
confirmation. 

Navigator 

Specification headlines are shown as a tree menu on the left panel. Numbering is added 
automatically to aid navigation. Clicking on the items will jump to the same requirement in 
the content area. 

Show / Hide Navigator 

Navigator can be toggled by clicking the pin icon. 

 
ReqEdit navigator pane on the left showing requirements hierarchy as a tree menu 



23 / 240 

 

 
ReqEdit navigator panel displaying Expand and Collapse all nodes in the document 

Requirement Numbering 

Requirements with (ReqIF.ChapterName) headlines are shown in a tree menu structure, 
numbered by the position in the hierarchy. The numbering is automatically updated on each 
change of the requirements, new additions or deletions will affect this. 

The levels of the menu represents sub items in the spec hierarchy. This is visible in the 
content as sub numbering of a main headline, all the content remains on a single level in 
the table. 

 
ReqEdit displaying a specification where the same requirement is selected in the navigator and the content area 
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To show/hide Chapter Numbers check the box Show Chapter Numbers in the Settings/User 
settings. 

 
User settings / Show Chapter Numbers box 

 

 
Show/hide Chapter Numbers result view 

 

 

Content 

Requirements are shown in the middle as a table, where the Main Column is a multi 
content field and the other columns are the associated metadata. 
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The Object menu (Right-click) 

Right clicking any object (row) in the content area, displays the context menu. Contains 
editing functions like: creating, cut-copy-pasting, deleting, restoring, purging objects. 
Hierarchical editing si possible by promote / demote menu items. 

Manage relations between objects by the lower menu items: Add, Edit, Delete link or Go to 
link targets. 

Get the object ReqIF ID using the Copy ReqIF ID menu item. 

 
Object context menu displaying Insert submenu with requirement patterns. These patterns can be customized as needed. 

 

 

Main Column 

Main Column is the most important content of the specification. It has the default value of 
the combination of headline (ReqIF.ChapterName), description (ReqIF.Name), xhtml 
content (ReqIF.text). If all there attributes are present it will be displayed together in the 
same cell and the headline will have a number assigned to it. 

The Main column content can be customized in the Document Settings panel. The attribute 
types supported are STRING or XHTML. 
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ReqEdit displaying a ReqIF file, main column is visible, highlighted is the column separator and a row separator 

 

 

Resizing columns or rows 

Drag the column header separator bars or the row separator bars to resize the grid. 

Content editing 

Double clicking on any object will enable the inline editor and activate the text formatting 
icon group. Right clicking the content will show a menu for adding attachments or tables 
and formatting the content. 

To leave the inline editing click anywhere outside the yellow background. 
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Managing columns 

Right clicking the column headers will display a menu, where the selected column or the 
other columns can be toggled visible or hidden. 

If all the columns are hidden the View manager can reset the visibility back to a predefined 
state. 
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ReqEdit colum management by right clicking the column header row 

 

 

Views 

Views are visible column sets with optional custom sorting and filtering saved as presets. 
The view manager is located in the icon groups on the right side. The views are only for 
displaying the ReqIF contents in a more human friendly manner for large files with lots of 
metadata. 

The view presets are not stored in a ReqIF file, they can be exported and later 
imported from the local hard drive. 
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ReqEdit displaying the view manager popup window 

 

 

Backups 

ReqEdit offers an auto-backup feature which will create a snapshot of the current state of 
the opened files. Default setting is to create a backup every 10 minutes and rotating 10 
backup files (the last will be deleted to have a max of 10 backups). 

The backup settings can be changed in the User Settings panel 

Show / Hide Backups 

Backups can be toggled by clicking the pin icon in the title of the panel 
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ReqEdit displaying a ReqIF file, highlighted is the auto-backup panel 

 

 

Backup Snapshots 

Backups can be locked so that it will not be deleted automatically on backup rotation. 

 
Backup settings for a backup snapshot 
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Menus 

File 

 
ReqEdit File menu 

 

 

New 

Create a new ReqIF file .reqif (New File) or an archive with attachments as .reqifz. (New 
Archive) 

ReqIF Archive supports attaching external images or files to any requirement. Creating a 
new archive will show a window asking for a filename. 

ReqIF (.reqif) 

No attachments 

CTRL+N 

ReqIF Archive (.reqifz) 

Can have attachments 
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CTRL+SHIFT+N 

A template list will popup will ask for a specific template to use for the new file. For more 
information on templates, please read the Templates section. 

 
Template selector window 

 

 

Open 

By default, only xml, rif, reqif, zip, reqifz and ReqEdit encrypted files can be selected 

 
Supported file types by ReqEdit 

 

 

Add new document to current file 
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Adds a new specification document to the currently active ReqIF file. Use this to add more 
than one specification to a single file. 

Save 

Any change in the specifications will be displayed with asterisk * in the tab. 

Changes to linked documents (e.g. Images or Word, Excel) will not be detected by the 
editor, a change needs to be made in the requirements in order to be able to Save 

Save 

Save the currently active file to disk 

CTRL+S 

Save As 

Save the active file under a new name 

Keep all UUIDs 

CTRL+SHIFT+S 

Save As for saving encrypted file 

To encrypt a file choose ReqEdit Encrypted File (*reqenc, *.reqzip) as file type then click 
SAVE. 

 

More about encryption of a file read here: ReqEdit File Encryption/Decryption 

Save as template 

Single document ReqIF files can be saved as a template and reused later 

Close 

Opened specifications can be hidden by clicking the X in the tab bar, if there are unsaved 
changes a popup will ask for confirmation. This is not removing the specification from 
the file. 

https://documentation.reqteam.com/?p=3653
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Close All 

Close all opened specifications, any unsaved change will notify the user. It will close all 
opened files. 

Import 

Start an import wizard for ReqIf 1.0.1 files 

Export 

Start an export wizard from ReqIF 1.0.1 to ReqIF compatibility mode or RIF 1.1 / RIF 
1.1a arhive format. 

Print 

Print the current specification Main Column or all visible columns. 

Connect 

Requires ReqEdit file server 

Will authenticate the current user and create a connection 

Check out 

Requires ReqEdit file server 

Lock the file and download for editing (other users that have permission to the same file 
cannot download it) 

Check in 

Requires ReqEdit file server 

Upload a file to the server. If the file was previously locked by the user it will become 
unlocked and can be edited by others as well. 

Edit 

https://documentation.reqteam.com/?p=2386
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Editing objects and contents 

Object / Requirement level editing 

Create before, after 

Create child 

Promote, demote 

Delete (soft delete) 

Restore deleted (soft deleted) 

Purge (hard delete) 

Cut/Copy/Paste 

Content level editing 

Table editing 
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Find 

Replace 

View 

 
ReqEdit View menu 

 

 

Attributes (columns) related 

Filtering 

ReqEdit can show a sub-set of the requirements based on special conditions of the 
attributes. Filters can be set and reset. Filters will not be saved inside ReqIF files. 

Sorting 

ReqEdit can sort the requirements based on multiple columns. It can be configured and 
then reset. The sorting is not saved inside the ReqIF file. 

Show/Hide deleted requirement objects 

Soft deleted objects will be marked for deletion but are not removed from a specification 
until PURGE is not pressed. The deleted objects can be shown or hidden 

View definitions (views) 
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Views are a sub-set of the attributes that are displayed. The views are not saved inside 
the ReqIF. file Views can be exported and later imported. 

The views can be imported and used on any specification as long as there are attributes 
with similar names. 

Settings 

 
ReqEdit settings menu 

 

 

Expert users can fine tune ReqEdit for their specific use case, and configure lots of ReqIF 
settings 

Document settings 

Manage ReqIF file internal settings 

Attribute Types 

Attributes 

Document attributes 

Links 

Configure Main Column display settings 

Server settings 

ReqEdit file server connection settings 

Server user credentials 

User settings 

ReqEdit internal configuration 
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Interface language 

Auto backup settings 

Doors table display settings 

Cache size 

Dashboard startup 
Date display format 
XHTML Schema validation 

Chapter Numbers showing 

Add-ons 

 
ReqEdit Add-ons menu 

 

 

Displays all available add-ons which are active in the current license. Descriptions below. 

Help 
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ReqEdit Help menu 

 

 

Contains a user guide. Can display Information about the active license. Display keyboard 
shortcuts. Check for online updates. Display version information about the current ReqEdit 
release. 

Add-ons 

ReqEdit Ultimate comes with powerful addons that extends the base functionality. 

Xml Editor 

Look inside ReqIF files and check the xml code. The editor comes with a built in ReqIF 
validation function that will debug any invalid code. Read more here. 

Excel importer 

Turn your excel files into ReqIF files. Data exchange is more realiable and lossless if ReqIF 
is used. Read more here. 

Compare / Merge tool 

Will generate a comparison report that can be handed out as a signle html file. Read 
more here. 

Weak-word Analysis 

Weak words are words that are confusing for readers and should be avoided if possible. 
This tool provides a case insensitive whole word search for this purpose, optionally writing 
the results back in the ReqIF file. Read more here. 

License Detach tool 

Take ReqEdit out of the licensing environment. This power feature will enable users not to 
depend on the local licensing servers and to be able to work from anywhere. Read 
more here. 

Expert knowledge 

Tab title configuration 

ReqEdit exposes some settings that can be configured for the tabs. The configuration file is 
located in AppData\Local\REQTEAM\ReqEdit\ReqEditSettings.xml 

https://documentation.reqteam.com/xml-editor-add-on/
https://documentation.reqteam.com/excel-importer-add-on/
https://documentation.reqteam.com/merge-compare-add-on/
https://documentation.reqteam.com/weak-word-analysis-add-on/
https://documentation.reqteam.com/license-detach-utility/
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Setting Values Notes 

TabDocumentTextAlign Left, Right Alignment of document title in the tab 

TabDocumentWidth 250px width of the tabs in pixels 

Keyboard shortcuts 

Ctrl+O Open file 

Ctrl+N New file 

Ctrl+S Save file 

Ctrl+Shift+S Save as 

Ctrl+W Close file 

Ctrl+Shift+W Close all file 

Alt+F4 Close application 

Ctrl+D Delete Sorting 

Ctrl+F Find text 

Ctrl+H Replace text 

Ctrl+E Add new or edit filter 

Ctrl+A Deactivate filter 

Ctrl+Q Delete filter 

Alt+N Add new object below 

Alt+Shift+N Add new child object 

Ctrl+Tab Switch between open tabs 

Ctrl+C Copy text information inside the cell 

Ctrl+X Cut text information inside the cell 

Ctrl+V Paste text (remove all formatings) 

Ctrl+Alt+S Start link 

Ctrl+Alt+E End link 

Ctrl+Alt+R Reset start link 

Ctrl+Alt+R Reset start link 
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F1 Open help 

F2 Open selected cell in edit mode 

F3 Check for update 

F5 License information 

F6 XML Editor 

F8 Document settings 

F9 Shortcut window 

 

 
Shortcuts used in ReqEdit 

 

 

Open ReqIF requirement files 

ReqEdit is used to display contents of ReqIF requirement exchange files including 
attachments and images in ReqIF Archive files. 

These are the key features: 

¶ ReqIF requirement objects 
¶ hierarchy structure 
¶ Internal UUIDS 
¶ attribute types 
¶ specification attributes 
¶ object attributes and relations 

For experienced users the XML Editor add-on can display the source code of the ReqIF 
file. 

Supported RIF/ReqIF file extensions: RIF contents (.xml .rif .zip) or ReqIF content (.reqif 
.reqifz) 

You can open decrypted *.reqedit files too, if you know the password. More about 
encryption / decryption read here. 

More about RIF and ReqIF files read here. 

Open file 

https://documentation.reqteam.com/?p=3653&preview=true
https://documentation.reqteam.com/reqif-requirements-format/
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Dashboard for ReqEdit 

 

 

To open a file 

¶ click on the Open Specification on the Dashboard or 
¶ select File > Open on the main menu or 
¶ press CTRL+O and then select the ReqIF file. 

 
ReqEdit displaying an opened ReqIF file 



43 / 240 

 

 

All containing specification documents are displayed as tabs in the tab bar. 

 
ReqEdit tab bar showing a ReqIF with three specifications 

 

 

Compatible ReqIF files 

If the file is not a standard ReqIF file but ReqEdit can import it, a popup notifies the user. 
Import wizard starts and completes the steps to open file. 

 
ReqEdit found an invalid ReqIF but asks the user for importing the file 

 

 

Multi ReqIF Archives 

If the opened document contains multiple ReqIF files (is an archive format .reqifz or .zip) a 
popup notification allows the user to select the files to open. 
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ReqEdit showing document selector for .zip or .reqifz files (containing two or more ReqIF files) 

 

 

In case of any ReqIF errors, ReqEdit identifies the errors. Use XML Editor Add-on to 
correct. 

 
Error message shows ReqEdit detected an invalid ReqIF source code 
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ReqIF file format 

ReqEdit follows ReqIF standard on all levels. It will display contents of ReqIF files from 
structural to attribute definitions. 

ReqIF format 

Attribute Types 
atomic data types: boolean, date, enumeration, int, float, string, xhtml 

Attributes 
uses the basic attribute type definitions with optional restrictions: min, max, length, can be 
defined for objects and specifications also 

Object types 
collection of attribute types that are grouped together 

Objects 
uses a specific object type and has values for each attribute 

Values 
value objects for attributes of objects or specifications 

Specification Types 
a collection of object types and specification attributes 

Specifications 
uses a single specification type 

Hierarchy 
requirement object structure inside a specification 

Relations 
links between the objects 

Documents 

ReqIF requirements are grouped into specification documents, these are displayed in 
the tab bar. Each opened ReqIF file will have its own random color to indicate that the files 
are together. 

 
ReqEdit tab bar showing colored dots in front of specifications that are contained in a single opened file 

https://documentation.reqteam.com/reqif-requirements-format/
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Hierarchy 

Each specification document has its own object structure which is shown in the navigator 
tab. 

 
ReqEdit displaying an opened ReqIF file, navigator on the left side is highlighted 

 

 

The navigator can be used to quickly jump to a specific section in the specification 
document. 

Numbering 
Automatically generated for each ReqIF.ChapterName which are used as headlines. Depth 
is determined by child objects. 

Objects 

Each row in the main content area is an object that has a Main Content and additional 
attributes. Objects are displayed as follows 
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ReqEdit displaying different types of requirement object states from top to bottom: 
not changed (white), edited and saved (blue), new not saved (green), deleted (red), with links (link icon, in, out, external) 

 

 

Status indicator 

First column of the grid is a frozen column, which means that the user will always see the 
column, even if the document will be scrolled horizontally. 

Displays the following states: 

¶ unchanged ï marked with white color 
¶ edited ï marked with light green 
¶ edited and saved ï marked with light blue 
¶ links - marked with link icon 

o internal links 
o external links 

Á URI / OSLC 
Á Inward / Outward 

¶ red - soft deleted (can be recovered) 

More about Editing objects you can read here. 

Attachments 

https://documentation.reqteam.com/edit-reqif-requirement-files/#Objects


48 / 240 

 
ReqEdit displaying attachment previews of an object, file icons and preview images 

 

 

Double-click on the icon. The attached file will be opened by the installed applications on 
the machine. 

Attributes 

Object attributes are displayed as columns inside the data grid. The default column layout 
starts with Main Column then the rest of the object attributes defined in the specification. 

By default all attributes are displayed in the specification as texts 

Main Column 

Displays the the main ReqIF attributes: ReqIF.ChapterName, ReqIF.Name, ReqIF.Text as a 
single cell where 

ReqIF.ChapterName - is displayed as Headline and will be auto numbered, displayed in 
the navigator 

ReqIF.Name - displayed in the content area as text 

ReqIF.Text - displayed in the content area as text 

The main column rendering can be customized in the Settings > Document menu 

Attribute columns 
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All columns can be set hidden / visible by right clicking on the column name row. 

 
ReqEdit column management menu displayed by right clicking anywhere on column names 

 

 

Attributes used in the current specification document can be displayed by opening Setting > 
Document and selecting the Attributes tab. 

Related topics: 

¶ Filtering and sorting 
¶ Views 

Edit ReqIF requirement files 

https://youtu.be/La-70CBGDno 
ReqEdit presentation video 

 
 

Why ReqIF files? 

Requirement Interchange Format is the de facto standard for lossless requirement data 
exchange for any industry. 

ReqIF simplifies the workflow of requirements exchange between suppliers and 
vendors in all industries. Mainly driven by the automotive industry. 

https://documentation.reqteam.com/filtering-searching-and-sorting/
https://documentation.reqteam.com/view-manager/
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ReqEdit was built from the ground up to aid the participants of the supply-chain to quickly 
use ReqIF files without the need for complex ALM/PLM software solutions. This is 
becoming more important with the digital transformation in more and more industries. 

ReqIF based interchange offers seamless integration of supply chains in all industries 
making collaboration more standardized and efficient. 

ReqEdit is an easy tool for ReqIF editing. Creating, comparing and merging requirements 
and specification documents with powerfull add-ons. 

Large companies rely on lossless data exchange 

ReqIF format simplifies and streamlines the data exchange of requirements between 
companies or departments and also on the management level. ReqEdit has multiple 
licensing models to support corporate environments and use cases. 

Medium or small size companies needs cost effective solutions to participate in the 
supply-chain 

ReqEdit is available as a standalone application. No other dependency is required. Cost 
effective solution for processing ReqIF requirement files. 

ReqIF file structure 

ReqEdit follows ReqIF standard on all levels. It will display contents of ReqIF files from 
structural to attribute definitions. More details you can find here. 

ReqIF format 

Attribute Types 
atomic data types: boolean, date, enumeration, int, float, string, xhtml 

Attributes 
uses the basic attribute type definitions with optional restrictions: min, max, length, can be 
defined for objects and specifications also 

Object types 
collection of attribute types that are grouped together 

Objects 
uses a specific object type and has values for each attribute 

Values 
value objects for attributes of objects or specifications 

Specification Types 
a collection of object types and specification attributes 

https://documentation.reqteam.com/reqif-requirements-format/
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Specifications 
uses a single specification type 

Hierarchy 
requirement object structure inside a specification 

Relations 
links between the objects 

Edit Objects 

Double click on a cell to edit the content. An inline editor appears for XHTML attributes. For 
other data types appear corresponding checkboxes or date pickers or single inputs. 

To close inline editing click on any other cell. 

The user can set the height of the main column: check the box in Settings / User ... / 
Calculate only main column row height. 

Use the quick action icons or the right-click menu for text formatting and XHTML content 
editing. 

 
Editing and text formatting shortcuts 
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Single valued enumeration will show a dropdown selector 

 

Multivalued enumeration attributes are displayed as a list of checkboxes 

 

Dates will show a datepicker 
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String types editing as simple text 

 

Boolean values editing as checkboxes 

 

Integer and float types will only store numerical values 

Insert rows 
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New rows can be created on the same level or as children to the current row. 

For inserting a new row at the same level of the current row, right-click on a cell and choose 
where to insert it. A new generic object is displayed as an empty line or with default values. 

Each spec object in ReqEdit has the same attributes (columns) in a document. Different 
object types are not supported in a single document. 

Insert child row creates a new row in the table, below the selected line. It is a child in the 
tree hierarchy. A new empty line will appear. In case it is edited it will look like this: 

 
ReqEdit displaying context menu 

 

There is a possibility to insert rows based on customizable requirement patterns. To offer a 
quicker way to build requirement documents. 

Use Insert row after.. and chose one of the patterns. 
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Delete rows 

ReqEdit uses soft-deletions, delete will not remove objects from the ReqIF file. 

Delete the selected row(s) by 

¶ selecting the row(s) and pressing DEL or 
¶ right-click menu or 
¶ the quick action icons. 
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ReqEdit displaying context menu, highlighted are the delete menu items 

 

To confirm Delete action click Yes in the pop up window which appears next. 

This function places the removed row(s) into a deleted state. (marked with red) 
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ReqEdit displaying deleted rows with red status indicator, highlighted is the Show deleted objects icon in the top bar 

 
 

Restoring deleted rows 

To restore a deleted row(s) select it/them and click on the ĂRestore deleted rowsò button 
from the toolbar or right-click on the object and select the Restore menu item. It is possible 
to restore multiple deleted rows. 

 
Restore deleted rows icon 

 

PURGE (definitive deletion) of deleted objects 

Use PURGE to remove objects, marked as deleted, with all attachments from a ReqIF file. 
Purge function is on the delete toolbars and right-click menus. 

Once purged, objects cannot be recovered. Auto-backup feature will have 10 snapshots for 
recovery. 

To clean up deleted rows: 

¶ purge a single deleted row or 
¶ purge all the deleted rows in the entire specification document. 
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Purge one row or all deleted rows icons 

 
 

Copy and move rows 

Use cut-copy-paste of existing row to create new one. Right-click the desired location and 
paste the copied object before / after or as a child row of another row. 

If a copied row contains links, on paste, a notification asks what to do with the 
existing links. 

If the row has child elements, these will also be copied or moved. 

 
Copy-paste rows 

 

To copy-paste multiple rows at a time select multiple rows and right-click on the last 
selected row, click Copy row than click on the first selected row and click Paste. 

Copy-paste in the Navigator 

Use right-click menu in the object navigator to copy-paste objects/rows. 

If an object contains links to or from other objects, the links are copied too. A pop up 
window asks for copying the links or not. 

Note: In Navigator is possible to copy-paste only one row at a time. 

Navigator drag-and-drop 

Use drag-and-drop to move objects 
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Object can be created by CTRL+Drag and release at the desired location 

Editing Hierarchy 

To change the hierarchy of objects use the promote and demote functions. They are in the 
quick action icons, and in right-click context menus. 

 
Promote / demote objects with right-click menu 

 

Promoting 

Will move the object one level up in the hierarchy. If using the drag-and-drop way for 
promoting, an object/ row can be moved more levels up or down. 

It is possible to Promote/Demote multiple rows of the same levels by selecting rows with 
shift and arrows than click Promote/Demote. 

Demoting 

Move the object one level down as children in the hierarchy. 

Promote or demote a parent object include promote or demote the object together with its 
child objects. 

Main column 

Main column is a combined cell displaying the most important ReqIF attributes: 
ReqIF.ChapterName, ReqIF.Name, ReqIF.Text 
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In this cell, the main fields of the document can be edited at once. These fields are XHTML 
type attributes. 

Double click the main column of an object displays an inline XHML editor with 3 tabs. One 
tab for each attribute. 

 
Cell content editor using buttons or mouse right-click 

 

The cell content editing menu Copy/Cut/Paste function refers to copy/cut/paste texts and 
pictures from the same document and external documents, too. (word file, excel 
spreadsheet cells, screenshots, images). The function converts external data format into 
ReqIF supported one. (text formatting doesn't see, image cannot be downloaded). File 
format must be ReqIFz to be able to save the images, as attachments. 

Note: Depending on corporate internet access, downloading copied images could be 
prevented by firewalls. ReqEdit will remove some formatting due to limitations of XHTML 
inside of the ReqIF format. 

Copy-Cut-Paste the text of cells of the same ReqIFz file has no limitations regarding the 
possibilities shown in the right click menu. (Bold, underline, italic, strikethrough, subscript, 
superscript) 

Copy-Cut-Paste of tables is with visible borders of cells. ReqEdit will add automatically 
borders to tables, even there was no set one before. 
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Note for experts with HTML knowledge: The HTML Source (experimental) menu item allows 
to edit and change the HTML source code of content of a cell. 

Limitations on content editing Copy-Cut-Paste function: 

¶ Cell formatting settings in Excel spreadsheet 
¶ Attached objects from Wordpad (RTF documents) 
¶ Images can be copy-paste only in ReqIFz files 
¶ If the image/attachment cannot be copied, only file name of the preview images are 

displayed. 

Recommendation: Before copy-cut content from an external source, save file to have a 
backup copy in case of the copied content is ReqIF invalid. 

Properties 

Properties menu gives information about the attachments / inserted files in main column 
cells. Right click on the inserted file, Properties 

 
Right click menu in editor mode shows Properties window 

 

HTML Source (experimental) 

This function of the right click menu of content editor is recommended to expert users. This 
function allows to view and change the html source code of the attribute/cell. 

Note: Currently the changes will not be validated at inserting time. So be very careful at any 
change! 
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Columns 

Mass update of attributes 

Update multiple rows with a specific attribute value. 

The mass update function is designed to be used together with the filtering. This way, 
a set of objects can be selected according to specific criteria and updated at the same time. 

The mass update function is not available for the main column 

To use Mass update function first define a filter to select all the rows you want to change. 
Then right-click on the column header. Select Mass update....A popup window appears. 

 
ReqEdit displaying the mass update menu item by right clicking the column header 
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Mass update popup window showing options 

 

Mass update changes all values in the current view for the column. 

To change individual cells, select multiple cells from the same column (either Ctrl + click or 
Shift + click). Right-click at the column heading to trigger the mass change. 

Default values 

Each attribute can have a default value defined in the Document settings. Selecting an 
attribute and access the ñAttribute editorò. 

To set back a cells default value for each attribute of a row, right-click the corresponding cell 
and select the ñSet default valueò. 

https://documentation.reqteam.com/document-settings/#Attribute-types
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Attachments 

ReqIF Archive .reqifz files supports file attachments for objects. 

Only XHTML attributes can have attachments inside .reqifz files 

Image attachments: 

png, bmp, jpg, gif, ico, wmf, 

File attachments: 

any file type is supported 

pdf, doc, docx, xls, xlsx ... 

Opening file attachments 

Double-click on the file's icon. The attached file is opened by the installed applications on 
the machine. 

Insert file attachments 
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To add an attachment right-click the XHTML inline editor area and select Insert 
image or Insert file 

 
ReqEdit displaying context menu, highlighted is the 'Insert image' item 
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ReqEdit displaying attachment previews of an object, contains file icons and preview images 

 
 

Tables 

XHTML attributes by definition can have tables. All tables are rendered inside cells. 

 
ReqEdit displaying tables inside XHTML attributes 

 

To edit XHTML table structure use the inline editor right-click menu. 

Save ReqIF files 

If your file is a multi-document file, saving one of the documents will also save the changes 
made in the other documents of the ReqIF file. 

NOTE: Changes on linked documents (e.g. Images or Word, Excel) are not detected. 
Make a content change to trigger update and enable saving. 



67 / 240 

Save as 

Save the currently edited file as a new filename. Contents will be identical to the original 
one. Can convert ReqIF into ReqIFz. 

Note: Actual file is closed and the file in new saved format will be opened. 

Save as encrypted file 

To encrypt a file choose ReqEdit Encrypted File (*reqenc, *.reqzip) as file type then click 
SAVE. 

More about encryption of a file read here: ReqEdit File Encryption/Decryption 

Close files 

ReqEdit can only close saved files. If there are any unsaved changes, a notification displays 
and asks to save files before closing. 

Use CLOSE ALL to clean up the editor. 

License activation 

General overview about the license activation options. For more details, click here. 

Automatic activation 

Activation is automatic for trial version and for some custom-tailored versions. 

Online activation 

(Public environment, internet/online access with no restriction) 

The License activator window appears. In the text box enter the Product key and press the 
Activate button 

https://documentation.reqteam.com/?p=3653
https://documentation.reqteam.com/license-management/
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Diagram of public environment with direct connection to ReqEdit License Server 

 

Follow the Activation steps 

Offline activation 

(Limited environment, with restriction on internet/online access) 

LicenseActivation.exe 

Access to ReqEdit License Server is restricted or not available. Manually activate license for 
the machine where ReqEdit is running. 

https://documentation.reqteam.com/activation/#Online-activation
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Offline activation with LicenseActivation.exe 

 

Offline Activation with LicenseActivation.exe 

RUS Tool 

 
Offline activation with RUS tool downloaded from the ReqEdit License Server 

 

https://documentation.reqteam.com/activation/#Activate-with-LicenseActivation.exe
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Offline Activation with RUS tool 

Network license server ACC 

(Public internet access is restricted due to internal security policies, and only a local license 
server is accessible) 

A self-hosted licensing server is installed on the restricted network. The server holds all the 
ReqEdit licenses, that can be accessed from any workstation inside the company network 
(no local license installation necessary). 

 
Diagram of restricted environment with self hosted ReqEdit License Server 

 

Setting up the Network license server 

License detaching 

Note: please inform REQTEAM if you plan to use detaching, so the license can be 
generated for this purpose. 

When users want to have a working copy of ReqEdit outside the restricted environment. 
License detaching is possible by using the Detach Tool Add-on. 

Detaching licenses will lock the license for a period of time for a specific machine. Locking a 
license has to be done inside the restricted environment, after which it can be disconnected 
from the network. 

https://documentation.reqteam.com/activation/#Activate-with-RUS-Tool
https://documentation.reqteam.com/activation/#Self-hosted-license-server-(Network-license)


71 / 240 

 
Diagram showing detach mechanism to work outside network license server 

 

License detaching 

Filtering, Searching and Sorting 

Filtering 

Filtering can be used to display only a subset of objects based on specific criteria. 

Filtering is temporary, rules are not saved. 

From the toolbar create filter, enable / disable current filter, delete filter can be used. 

 
ReqEdit toolbar highlighted are the filtering icons 

 

https://documentation.reqteam.com/activation/#License-detaching
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Filters can be constructed by the toolbar icons, then later edited or deleted. 

 
ReqEdit filter editor popup window 

 
 

Searching 

Activate the search bar from the toolbar or by pressing CTRL+F 

 
ReqEdit search bar displayed above the main content area 

 

Search can be done in three contexts: 

¶ Main Column: search only in ReqIF.ChapterName, ReqIF.Name, ReqIF.Text 
¶ Entire document: all attributes 
¶ ForeignID: search only in ReqIF.ForeignID (only if the attribute is present in the 

current document) 
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ReqEdit searching, found result displayed in green cell background 

 
 

Search and Replace 

Replacing values or part of values depending on the search can be done by 
pressing CTRL+H enabling the replace bar 

The replace function works only for the Main Column 

 
ReqEdit displaying Search and Replace bar above main content area 

 

Skipping a specific replacement press the Next button 

Replace all will do the replacements in the contents of the Main Column then display the 
total count of replacements. 

Sorting columns 

Columns can be sorted ascending or descending by clicking or by right clicking on the 
column header. Each sort will reset the previous sorting. 
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ReqEdit column sorting menu by right clicking on the column headers 

 
 

Multi-column sorting 

To have multiple sorting CTRL+click the column headers you want to sort. A numbered 
arrow will display the sorting order. To change the ordering press CTRL+click again on the 
column 

 
ReqEdit multi column sorting displayed by numbered arrows in the column headers 

 
 

Reset sorting 

Press the delete sorting icon in the toolbar or press CTRL+D 

 

View Manager 

What are views? 

Views are visible column sets with optional custom sorting and filtering saved as presets. 
The view manager is located in the toolbar icon groups on the right side. 

The views are only for displaying the ReqIF contents in a more human friendly manner for 
large files with lots of metadata. 
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The view presets are saved in the ReqIF file 

Views can be exported and later imported from the local hard drive 

 
ReqEdit displaying the view manager popup window, highlighted is the view manager toolbar 

 

There are two system views defined per each document which cannot be deleted: 

All Attributes - show all the columns in the document 

Main column - show only the main column 

 
View selector in the toolbar 

 
 

Manage views 

To be able to manage views user defined views has to be created by clicking the Create 
new view icon 
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View toolbar icons, selected is the Create new view icon 

 
 

Create or edit views 

Pressing the Edit view icon the view editor popup window is displayed. The toolbar icons 
are: 

¶ Rename 
¶ Save 
¶ Save and Apply, will show the applied view in the main content area 
¶ Delete after confirmation the view is deleted 
¶ Make a copy of the view by setting a new name 
¶ Export the current view in a .view file 
¶ Import .view files. Only existing column names are imported 
¶ Cleanup, will leave only the visible columns in the document, a confirmation popup 

lists all the views / attributes that will be removed. This operation saves the 
document so a backup is highly advised. 
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View editor window 

 

A certain view can be set as default. If specified, the ReqEdit opens the default view on 
start. 

Filtering 

Views can inherit filtering from the current document. Press Copy filter from editor to save 
the filter into the view. 

Show deleted objects filter can also be used 

Toolbar 

Creating new views 

Clicking the Add View button will ask user for the new view name and preparea it will all the 
attributes added to it 

Editing views 
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User can edit the view in the main gui with rightclicking the column names or by opening the 
View manager panel by clicking the icon to the right 

 
View manger toolbar, highlighted is the Edit view icon 

 
 

Deleting views 

User can delete the selected view if itôs not any of the system views by clicking the Delete 
View button located in the toolbar 

Printing 

How to print requirements? 

ReqEdit supports printing the Main Column or all the visible contents of the current 
document. File \ Print will show the two options. 
 
The print document is based on a template file located in: ReqEdit\Data\Templates\Print 
folder. It can be customized as needed. 

Print Main Column 
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Print All visible columns 
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Customize the current view with filters and sorting to prepare a custom view for the print. 

Customize the output 

ReqEdit offers print customization of the header, footer and cover pages. Access the File > 
Print > Print Settings menu item for displaying the customization window. 
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Print customization 

 

Settings 

Expert users can fine tune ReqEdit for their specific use case, and configure lots of ReqIF 
related settings 

 
ReqEdit settings menu 
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Document settings 

Manage ReqIF file internal settings 

Attribute Types 

Attributes 

Document attributes 

Links 

Configure Main Column display settings 

Server settings 

ReqEdit file server connection settings 

Server user credentials 

User settings 

ReqEdit internal configuration 

Interface language 

Auto backup settings 

Doors table display settings 

Cache size 

Dashboard startup 

Document Settings 

Read the chapter Document Settings for an in depth overview. 

User settings 

ReqEdit can be displayed in two languages: English and German. 

To change the language, press Save and then restart ReqEdit. 

Temporary files 

https://documentation.reqteam.com/document-settings/
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Using ReqIF files produces temporary files like: previews, caches, ReqIF Archive objects, 
and activity logs. 

Automatically each time ReqEdit is exited, the log and temporary files that are older than 6 
months will be gradually deleted. 

By pressing the Delete temporary files button all logs and backups including backup 
snapshots will be deleted, offering workspace cleanup for the current user of ReqEdit. 

Backups 

When a file is saved for the first time, ReqEdit automatically makes a backup copy of the 
initial state of the file and also starts the timed backup process. By default, the program 
creates a backup every 10 minutes until it reaches 10 backup files. After that, the oldest 
backup file will be overwritten. The number of minutes and number of backup files can be 
changed by the user in the User settings panel. 

 
ReqEdit displaying a ReqIF file, highlighted on the right side is the auto backup panel displaying available backups 

 

The timed backup process can also be disabled by unchecking the [Create backup] 
checkbox in the Settings > User panel. 

By default, ReqEdit stores the backups in the Windows user folder. This is a Windows 7 
location sample: C:\Users\user_name\AppData\Local\ReqEdit\ReqEdit\BackUpFiles 
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The locations of the Log and Backup folders can be changed. More information can be 
found in the Program environment chapter. 

Image caching 

Limit the RAM memory used by ReqEdit. Default value is 500mb, but can be increased to 
gain more speed. 

ReqEdit uses image caching to speed up displaying XHTML contents of the ReqIF files. If 
the ReqIF files are big, increasing the cache size could be a good idea. 

XHTML Validation 

In some cases it is recommended to turn off the XHTML validation to save the invalid ReqIF 
document. Then correct the XHTML errors in XML Editor Add-on. This option should be 
always enabled to have maximum compatibility. The change of this setting is instantaneous, 
there is no need to close and re-open the software. 

Read more on XHTML Validation Error 

GUI settings 

 

Enable "Calculate only main column row height" for better readability of the main column. 

Disable "Show Chapter Numbers" to have a pure view over the ReqIF structure. 

To see the changed settings, close and re-open the program. 

Date format 

This format will be used to display dates. To see the changed setting, close and re-open the 
program. 

https://documentation.reqteam.com/xhtml-validation-error/
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Server settings 

This requires a ReqEdit Server instance and to be accessible on the internet. 

Read more on the Collaborative work with ReqEdit Server 

The focus of ReqEdit Server is to keep the file management effort as low as possible. The 
server offers a central point where you can organize and work with ReqIF files in ReqEdit. 
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ReqEdit Server settings 

 

Enter credentials for ReqEdit Server and press Test Connection then Save. 

Once a valid configuration is saved press Connect from this window or from the toolbars or 
the File menu. 

 
ReqEdit Server connection toolbar 

 



87 / 240 

Document Settings 

Before describing the document properties, lets go through the internals of the ReqIF files. 

TLDR jump to Document properties 

Attribute types 

Each specification document has its own set of attribute types that are used as attributes. 
The list can be displayed using the menu Settings > Document. 

Automatic data types for documents 
Each new document will have: integer, real, date, string, xhtml and boolean attribute types 
automatically created, which can be edited. 

 
ReqEdit displaying list of attribute types of a specification document, highlighted is the data type column which displays the base type and 
restrictions of the attributes. Selected is an enumeration type attribute and the enumeration values are displayed on the right bottom in the 
Enumeration Type Values list box 

 
 

Data types 

https://documentation.reqteam.com/pdf/?html#Document-Properties


88 / 240 

Attributes in ReqIF files are constructed from underlaying data types with or without 
restrictions. The usage of restrictions in the data types can make the requirement 
specifications more robust by not letting invalid values to be used. 

Properties of data types 

Depending on data types, different properties are available. The following table describes all 
available properties per data type 

  Long Name Description Min Max Accuracy Enum Values 

Boolean X X         

Date X X         

Enumeration X X       X 

Integer X X X X     

Real X X X X X   

String X X   X     

XHTML X X         

Boolean 

Its value can be true of false. These two states are displayed by a check box on the screen. 
This is an exception type, double click on the cell is not necessary for editing. Its value can 
be altered by a single click. 

Date 

A real date can be written or set as its value. In the view mode, the cell shows the value of 
the date, but in the edit mode it displays the DateTimePicker controller used for selecting 
the date. This offers help for the user to select fast the exact date. The date value can also 
be removed by unchecking the box in the top left corner of the date picker. 

Integer 

An integer can be given as a value between previously determined limits. In case of not 
giving a numeric type, the program will display an alert and the user can only continue if a 
correct value is entered. 

Real 
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The value can be a decimal number between previously determined limits. In case of not 
entering a numeric type, the program will display an alert and the user can only continue if a 
correct value is entered. 

String 

An unformatted text with a previously determined length can be entered as a value. 
NOTE: The maximum allowed length of a string is 600 characters. This limitation was 
imposed in order for the files to be compatible with IBM Rational DOORS. 

Enumeration 

Represents a list of fixed values that can be used. 

Each value has a Numeric Value, a Label displayed to the user, and an optional color in 
HEX or named color. 

 
Enumeration type editor window 
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XHTML 

XHTML format permits formatting of text in multiple ways, similar to any text processing 
application: Bold, Italic, Underline, Strikethrough, Superscript, Subscript, Unordered list, 
Ordered list, Paragraph, Normal text, Heading 1 ï Heading 6 

In addition to text formatting tables and images can be used in the content, as well as file 
attachments. 

URI 

The URI Represents the Resource types defined by DNG data models. All the attribute 
definitions, attributes, enum values may have URI values defined. 

Attributes 

Using the defined attribute types, attributes can be created to be used in the document or 
the objects. Each data type has its own properties shown in the following table 

  Long Name Description Read Only Multivalued Default Value 

Boolean X X X    X 

Date X X X    X 

Enumeration X X X  X X 

Integer X X X  X 

Real X X X  X 

String X X X   X  

XHTML X X X    X  

 

Each data type has its own properties 

 
 

Enumeration attributes 

Using enumeration data types in attributes has two main use cases 

Single-value enumeration 

You can choose only one value from a previously determined value set. It shows the 
chosen value in cell viewer mode. In the editor mode you can choose the required value 
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from a values list (ComboBox or DropDownList). 
Besides the values of an enumeration attribute type, the user can also select the value to 
remove the value of a cell. 

Multivalue enumeration 

You can choose multiple values from a previously determined value set. It shows the 
chosen value in cell viewer mode. In the editor mode you can choose the required values 
from a list by selecting each check box. 

 
Multivalued enum attribute displayed as list of values with colors 
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Single value enum attributes are displayed as text 

 
 

Document Properties 

Information related to a specification document is visible in the Document tab. Document 
Name, description, attributes and statistics. 

Statistic Information of: 

¶ Documents in file 
¶ Rows in selected document 
¶ Attributes in selected document 
¶ Attribute types in selected document 
¶ Incoming and outgoing links 

Attributes that are defined internal to the specification are also listed with the value 
displayed on the right side. 

 
ReqEdit displaying document properties 
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Main Column (heading and text) supports STRING and XHTML as attribute type. 

Specification types 

Currently not displayed, internally will be created and used exactly as in the ReqIF 
standard. 

Object Attributes 

List of attributes used in all objects of the selected document. 

 
Object Attribute management window 

 

System attributes are displayed by a PC icon in the list, these attributes cannot be 
deleted 

ReqEdit internal attributes 
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¶ ReqEditID ï integer type, read-only attribute, internal unique ID 
¶ ReqEditModifiedOn ï date type, read-only attribute, last modification date of the 

object 
¶ ReqEditModifiedBy ï string type, read-only attribute, stores the Windows username 

who edited the object 

Import attributes from other file 

To import attributes from an other file: 

1. Open both files 
2. Click on Document settings\ Attribute tab\ Import 
3. Select source ReqIF 
4. Select the attributes to be imported 
5. Click Save 

In case of Attrybute type - enumeration, 

¶ If enumeration attribute exist - after importing, the new values will be added to the 
enumeration. 

¶ if attribute already exist and type is not the same - the old attribute will be renamed 
to "... OLD" and does nothing to it 

SpecObject types 

Currently not displayed, internally will be created and used exactly as in the ReqIF 
standard. 

Links 

Are covered in the Links chapter 

License Management 

Automatic activation. 

Activation runs automatically for trial version or for some custom-tailored versions. 

On the last step of the installer the checkbox remains at default settings. 

https://documentation.reqteam.com/chapter/links/
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Window Start Activation Setup 

 

LicenseActivator.exe starts without displaying User interface. It detects .v2c file and 
activates the product. 

ReqEdit opens automatically. 

Online activation 

After installation 

Note: You need to have non-restricted Internet acces, or need to configure the proxy 
settings for it. 

The License activator window appears. If not, run the LicenseActivator.exe in the ReqEdit 
folder. In the text box enter the Product key and press the Activate button. 
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Diagram of public environment with direct connection to ReqEdit License Server 

 

 
License activator window 
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Activation done 

 

Activation done. Run ReqEdit. 

Offline activation 

This activation allows running ReqEdit when access to ReqEdit License Server is restricted 
or not available. Create manually a license for the machine where ReqEdit is running. 

In this case there are 2 options for activation: Activation with the file LicenseActivation.exe 
or Activation using the RUS Tool. Through them you can generate a .c2v file which you 
need for creating the license for your PC. 

 
Activation with LicenseActivation.exe 
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Activation with RUS Tool 

 

Activation with LicenseActivation.exe 

Activation with RUS Tool 

Activate with LicenseActivation.exe 

The offline activation needs the following: 

¶ product key (got with purchasing ReqEdit) 

¶ machine generated .c2v file (follow the next steps) 

Open ReqEdit folder and click LicenseActivation.exe in the ReqEdit folder. 

Pops up License activator window.  Here generate C2V file 

Save the file into the suggested folder or elsewhere  

https://documentation.reqteam.com/activation/#Activate-with-LicenseActivation.exe
https://documentation.reqteam.com/activation/#Activate-with-RUS-Tool
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Generate c2v file in Offline activation 

 

At an online workstation login with Product key at the Sentinel EMS Customer portal  

https://license.reqteam.com/ems/login.html 

 
Sentinel EMS Login 

 

Choose Offline Activation tab. A new window appears. 

In the Generate License window upload the saved C2V file. 

Then click Generate.  

https://license.reqteam.com/ems/login.html
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Uploading the .c2v file 

 

The Key ID. appears 

Download the VC2 file  

 
Downloading the V2C file 

 

Go to the License Activator window and press Activate button 



103 / 240 

 
Activate offline with key 

 

In the Browser window select V2C file  

Press Open  
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Open ReqEdit and start working with it. 

Activate with RUS Tool 

¶ Login to the customer page of REQTEAM license management 
(https://license.reqteam.com/ems/customerLogin.html) 

¶ Enter your license key from your license 

 
Sentinel EMS login 

 

Click on the Offline Activation Button 

Appears Generate License window 

https://license.reqteam.com/ems/customerLogin.html
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Download RUS tool 

 

Download RUS tool (RUS_OWOZQ) 

Some antivirus program can delete or quarantine this file. So, keep it when the antivirus 
asks for deleting or putting into quarantine. 

  
Keep RUS tool 

 

1. execute RUS tool 
2. select Collect Status Information and select C2V file type. 
3. select Installation of new protection key 
4. press Collect Information 
5. save the C2V file 
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Generate c2v file 
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Save c2v file 

 

C2V file can be used for license related operations. 

At an online workstation login with Product key at the Sentinel EMS Customer portal 

Upload the C2V file to Sentimel EMS. 

https://license.reqteam.com/ems/customerLogin.html
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Upload c2v to EMS 

 

Press Generate to generate V2C file. 

Download V2C file to your PC. 

 
Download v2c 

 

1. execute RUS Tool 
2. select tab Apply License File and select the V2C file 
3. press Apply Update to activate the license on the machine 
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Apply update V2C 
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Activation done 

 

Activation done! 

You can start to work with ReqEdit. 

Network license server ACC 

A self-hosted licensing server is installed on the restricted network. The server holds all the 
license pools that can be used and has to contain a current snapshot of the license 
database from ReqEdit License Server. 

Downloads 
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Download haspdinst.exe for windows 

Version Downloads 

Sentinel ACC haspdinst.exe 10.11 
haspdinst.zip CRC 
haspdinst.exe CRC 

 

ACC windows versions 

 

Download aksusbd.tar for linux 

Version Downloads 

Sentinel ACC aksusdb.tar 8.53 aksusbd-8.53.1.tar  

 

ACC linux versions 

 

Add note: please inform REQTEAM if you plan to use detaching, so the license can be 
generated for this purpose. 

Installing 

https://documentation.reqteam.com/wp-content/hasp/haspdinst.zip
https://documentation.reqteam.com/wp-content/hasp/haspdinst.zip.sha256
https://documentation.reqteam.com/wp-content/hasp/haspdinst.exe
https://documentation.reqteam.com/wp-content/hasp/haspdinst.exe.sha256
https://cloud.reqteam.com/downloads/thales/8.53/aksusbd_113498-8.53.1.tar.gz
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Diagram of restricted environment with self hosted ReqEdit License Server 

 

NOTE:  The installation needs to me made on the "future" license server. 

NOTE: Windows can detect the haspdinst.exe as untrusted, Run Anyway 

¶ Port 1947 has to be opened 
¶ Type haspdinst -i in the command line. The installation or upgrade process is 

performed automatically. A message is displayed informing you that the Sentinel 
LDK Run-time Environment was successfully installed. 

On windows execute the following command to start the installation: 

haspdinst - i  

You can find an extended manual if you run the program in Windows File Explorer. 
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To check the status of the installation execute the command: 

haspdinst - info  

The version of the "Installed Package Drivers" needs to be 8.53 

To check the status of the installation execute the command 

haspdinst -info 

In the ReqEdit application folder you need to start the executable "Start.exe" or 
"LicenseActivator.exe" depending on the version you have and insert the FQDN or IP of 
your license server.  

Read more on the topic here Installation guide Thales/Sentinel LDK EMS 

Updating 

The update of the ACC needs to be done exactly like the install. 

Fist stop the windows service (press windows START then type "Services") with the 
name "Sentinel LDK License Manager" and then execute 

haspdinst - i  

Uninstalling 

To remove Sentinel license server on Windows execute 

haspdinst.exe - r  

if for some reason the uninstallation does not work, you can force remove with 

haspdinst.exe - fr  

Setup 

NOTE: The operation MUST be done on the machine where ACC is running. 

Login on the ACC license server from the same machine and select the menu 
ñConfigurationò 

1. Go to the license server webpage http://localhost:1947 

2. Allow Remote Access to ACC  as HTTP or HTTPS 

https://docs.sentinel.thalesgroup.com/ldk/LDKdocs/Install/Installation%20Guide/RTE_using_Utility/haspdinst.exe%20Utility.htm
http://localhost:1047/
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3. Set Password - to access the configuration pages, also it will be used for Detach Tool 
later on 

 
ACC server configuration for HTTP or HTTPS access 

 

4. Open [Access From Remote Client] tab and set FQDN of the server 
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ACC server Access from Remote Clients tab 

 

Press Submit to apply 

5. Network settings 

Set EMS URL to https://license.reqteam.com 

 
ACC Network settings 

 

Online License Activation 

NOTE: The operation MUST be done on the machine where ACC is running. 

Access the ACC server from the same machine http://localhost:1947 - just to make sure the 
local ACC is running. 

1. Go to the customer login page https://license.reqteam.com/ems/customerLogin.html. 
You need to insert the product key to login. 

http://localhost:1047/
https://license.reqteam.com/ems/customerLogin.html
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Login Sentinel EMS 

 

2. Press Online Activation 

 
REQTEAM EMS License server Online Activation button 

 

3. Check that the local ACC received the licenses 
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Local ACC server product list displaying received local licenses 

 
 

Update Licenses 

NOTE: ACC network settings MUST be configured so that EMS URL 
is https://license.reqteam.com (read previous chapter) 

NOTE: The operation MUST be done on the machine where ACC is running. 

Go to the customer login page https://license.reqteam.com/ems/customerLogin.html. 
Access License Update tab and press Update Licenses 

The new licenses will be updated to the ACC server automatically. 

https://license.reqteam.com/ems/customerLogin.html
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Update licenses to local ACC server 

 

Offline License Activation 

C2V on Windows 

Go to the license server webpage http://localhost:1947 and select the "Sentinel Key" item.  

 
ACC server showing the vendor keys, download the Fingerprint 

 

press the "Fingerprint" button and save the C2V file in the downloads folder.   

Step 1: Got to the customer login 
page https://license.reqteam.com/ems/customerLogin.html. You need to insert the product 
key to login. 

http://localhost:1047/
https://license.reqteam.com/ems/customerLogin.html
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Login Sentinel EMS 

 

Step 2: Select "Offline Activation". 

Step 3: Upload the created .c2v file. 

Step 4: Click the "Generate" button and save the .v2c file to a folder you like. 

 
Upload c2v file 
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Update/Attach licenses 

Step 5: Download the generated V2C file (or the V2C file received from us) 

 
Download V2C file 

 

Step 6: Upload to your local license server http://localhost:1947 in the menu 
"Update/Attach". 

 
ACC server update/attach V2C license file page 

 

Step 7: Check in in the menu "Products", if the license was correct inserted/updated. 

C2V on Linux 

If you are using Linux, the procedure is a little bit more complex. You need to log in to your 
license server (ACC) and click the tab "Diagnostics". Here you find a button named 

http://localhost:1947/
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"Generate ID File". After clicking this button you got an ID file to save. Please save this file 
to a local drive and change the file extension to .c2v. 

Now open this C2V file in a text editor and change the structure of the ID file, which should 
look like this (characters truncated with ...): 

<?xml version="1.0" encoding="UTF - 8" ?>  

<location>  

<license_manager id="F07reQmW9igotxo.....1b4VD5kRUi4qsA" time="0">  

<version>24.4.1.110802</version>  

<hostname>safenet</hostname>  

<name>SAFENET</name> 

<host_fingerprint type="SL - AdminMode" crc="123456789">  

MXhJSYlJIQewwFkjBPbITRjkSqpKZebAq3PcANCwG............==  

</host_fingerprint>  

</license_manager>  

</location>  

and change the file to this: 

<?xml version="1.0" encoding="UTF - 8" ?>  

<hasp_info>  

<host_fingerprint type="SL - AdminMode" crc="123456789">  

MXhJSYlJIQewwFkjBPbITRjkSqpKZebAq3PcANCwG............==  

</host_fingerprint>  

</hasp_info>  

Terminal server network license URL 

New terminal server users do not need to configure the ReqEdit server license URL each 
time. Instead, it's possible to establish the ReqEdit license server URL permanently by 
setting it as an environment variable on the server. 

Go to System properties/ Advanced / Environment variables... 
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System properties settings for environment variable 
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Complete the variable name with REQEDIT_LICENSE_SERVER 

Note: Variable name is key sensitive. 

Variable value: FQDN of the ACC server 
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Environment variables settings 

 

License detaching 

Note: please inform REQTEAM if you plan to use detaching, so the license can be 
generated for this purpose. 



125 / 240 

When users want to have a working copy of ReqEdit outside the restricted environment. 
License detaching is possible by using the Detach Tool Add-on. 

Detaching licenses will lock the license for a period of time for a specific machine. Locking a 
license has to be done inside the restricted environment, after which it can be disconnected 
from the network. 

 
Diagram showing detach mechanism to work outside network license server 

 

NOTE: : To be able to use ReqEdit on a workstation which leaves the company network, 
you need to detach a license for it. To achieve this goal ACC must be installed on the 
workstation! 

Installing ACC on the workstation (jump to ACC install section) 

Configuration of ACC is not needed. Detach tool will handle the license transfer 
automatically. 

Requirements 

https://documentation.reqteam.com/pdf/?html#Installing
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The ReqEdit Detach tool needs to run on a Windows operating system with .Net library (at 
least version 4.8 or higher) installed. 

Additional the Sentinel Admin Control Center needs to be installed and configured locally. 
Please ensure that a valid VLIB DLL (i.e. haspvlib_113498.dll is corresponding for ReqEdit 
licenses) is installed. The file needs to be in the folder. 

ñC:\Program Files (x86)\Common Files\Aladdin Shared\HASPò. 

About detailed requirements, read more here. 

Enable Detaching on ACC server 

3. Go to the Detachable Licensing Tab 

Please activate the checkbox ñEnable Detaching of Licensesò. You can determine the 
maximum detach duration in days. 

Additional you can set the number of licenses you want to keep on the server (to be not 
detachable) in the field ñReserved Licensesò. Here you can enter either an absolute number 
or a percent value. . 

If you want to do different settings for your different products, you can do this by click on the 
button ñPer-Product Settingsò. 

 
ACC Detach license tab 

https://documentation.reqteam.com/starting-reqedit/#System-Requirements
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Configure Detach tool 

The tool has to be configured on the workstation 

Open Reqedit\AddOn\Lm\ReqEditLm.exe.config 

 
ReqEditLm.exe.config location in Windows Explorer 

 

Set server address to the ACC server 

serverAddress - 10.0.0.10 or the FQDN like: server.localdomain.local 

...  

<setting name="LicenseServerAddress" serializeAs="String">  

<value>server.localdomain.local</value>  

</setting>  

...  

Generate config.dat 

reqeditlm.exe - pass password - out config.dat  
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password - the access password for ACC server (that was set in the previous steps) 
outfile - config.dat the file that will be used in the config xml 

NOTE: If you want to use different out file please update the xml to use that 

To use the Detach Tool please open Users Guide 

License Updates 

If your license is arriving the expire date or even some days before we will provide you an 
update key (file ending .V2C) and you request a new one. 

A. You do not have a license manager installed (no ACC) 

You need to activate this license with your "LicenseActivation" tool from ReqEdit client. 
Select offline activation and press the "Activate" button and select the V2C File to update 
your license. 

 
Update License window 

 

At an online workstation login with Product key at the Sentinel EMS Customer portal  

https://license.reqteam.com/ems/login.html 

https://documentation.reqteam.com/license-detach-utility/
https://license.reqteam.com/ems/login.html
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Sentinel EMS Login 

 

Choose Offline Activation tab. A new window appears. 

In the Generate License window upload the saved C2V file. 

Then click Generate.  

 
Uploading the .c2v file 
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The Key ID. appears 

Download the V2C file  

 
Downloading the V2C file 

 

Go to the License Activator window and press Activate button 
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Activate offline with key 

 

In the Browser window select V2C file  

Press Open  
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License activator window, offline activation tab, license activation success 

 

Open ReqEdit and start working with it. 

B. You have a license manager installed and you don't have a V2C file 

Alternatively you can update automatically if you have installed a license server (Admin 
Control Center in the minimum version 8.31) on the computer that holds the license. You 
need to open the url https://license.reqteam.com/ems/customerLogin.html on this computer 
and click license update. 

https://license.reqteam.com/ems/customerLogin.html
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EMS Login 

 
 

C. You have a license manager installed, but with no or restricted internet acces 

Login to Sentinel EMS Customer Portal. Open the 
url https://license.reqteam.com/ems/customerLogin.html and enter Product Key. 

 
Sentinel EMS Login 

https://license.reqteam.com/ems/customerLogin.html
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Upload the C2V file to Sentinel EMS. Press Generate for generating v2c file. 

 
EMS C2V file upload 

 

Download the generated V2C file. 

 
Download V2C file 
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Upload the generated .v2c file to your local server ACC in the menu "Update/Attach". 

 
ACC server update/attach v2c file 

 

Transfering License 

To transfer an user license from an old PC to a new PC you need the RUS tool on both 
PCs. 
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License transfer diagram between two machines 

 
 

Download RUS Tool 

You can download it from our customer area: 

https://license.reqteam.com/ems/customerLogin.html 

For login you need to enter your product key, use the key you already used for activation. 

After login you click on Offline Activation button and download the RUS tool. 

https://license.reqteam.com/ems/customerLogin.html
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Download RUS tool 

 
 

Generate ID file 

IF YOU USE ACC (LICENSE SERVER) 

For transfering License from a Network license server to another , you need to have a 
Rehostable license. 

Open ACC on the new server to generate the ID file 

Go to Diagnostics of your license server and click on "Create ID file" button on the top right 
of the page 
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Generate ID file for license transfer 

 

Save the file generated. 

IF YOU DON'T USE ACC (LICENSE SERVER) 

Execute the RUS tool on the new PC, where you want to have the license transferred. 
Select the Transfer License tab. Please press on the [...] button to select the location and 
choose a name for the Recipient Information ID file (the name of the file is not important). 

Press Collect and Save Information to generate the file. If the process was successful, 
you will get a confirmation window. 
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Generate ID file 

 

Copy the generated Recipient ID file to the old PC, where the active license is. 

Please do not close the RUS tool on the new PC, we need it for later. 

Generate license transfer file 

Run the RUS tool on the OLD PC.  

Select the Transfer License tab. Check if your license is transferable, it has to be listed in 
the license list. 

Note: If the license is not transferable you need to contact the REQTEAM support team to 
initiate a manual transfer. 

Note: if you use ACC you need to have Rehostable license. 

 
Rehostable license icon for ACC user 

 

Select the license you want to transfer from the list 

Select the Recipient Information ID file copied from the NEW PC. 



140 / 240 

Select the destination of the Transfer License File, by selecting the [...] button. 
Press Generate License Transfer File button. 

The .h2h file needs to be copied to the NEW PC. 

 
Generate license transfer file 

 

You can close the RUS tool on the OLD PC. 

Activate license transfer file 

IF YOU USE AN ACC (LICENSE SERVER) 

Upload the generated H2H file in your new ACC in the menu "Update/Attach". 






































































































































































































